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This QuickStart Guide is intended to get you up-and-running 
with EasyCatalog as quickly as possible. Further information 
on the features of EasyCatalog can be found in the User 
Manual.

Several data and InDesign files accompany this tutorial, and 
are required to follow the steps outlined in the tutorials later 
in the guide. By following these actions, you should be able 
to quickly configure EasyCatalog and gain an insight into the 
options available for working with your data.

You do not need to complete every section in this tutorial – 
only the first, ‘First Steps’, is required.

 Where you are required to take action, the icon on 
the left will be shown.

!
Important information will be highlighted using 
this ‘warning’ icon.

i Additional, non-important, information is shown 
using the ‘Information’ icon.

If you have any questions regarding EasyCatalog, please 
don’t hesitate to ask using the support form on our web site:

http://www.65bit.com/support

About this Guide

Supporting Files


This tutorial uses a number of supporting files which can be downloaded from our web site:

http://www.65bit.com/downloads/easycatalog/files/QuickStartGuide.zip

Tutorial Files

stock.csv Example data file

Tutorial 5.indl Formatted tables example

Tutorial 7a.indl Simple flow-based pagination example

Tutorial 7b.indl Grouped data pagination example

Further support material, including the full User Guide, is available for download from our web site: 
http://www.65bit.com/products/easycatalog/downloads/downloads.shtm

We also have a number of tutorial videos which highlight the main features of EasyCatalog:
http://www.65bit.com/products/easycatalog/videos/videos.shtm

Installing EasyCatalog
A fully-functional 30 day trial of EasyCatalog can be 
downloaded from our web site:

http://www.65bit.com/downloads/downloadpre.shtm

During the installation process, you will be prompted 
to select the modules to install.  Some of the tutorials in 
this  Quick Start Guide use the Pagination Module.  If this 
module is required to complete any of the tutorials, it will be 
highlighted at the start of the tutorial.

!
Note that the Pagination Module is an optional 
module that must be purchased in addition to 
EasyCatalog.

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
http://www.65bit.com/support
http://www.65bit.com/downloads/easycatalog/files/QuickStartGuide.zip
http://www.65bit.com/products/easycatalog/downloads/downloads.shtm
http://www.65bit.com/products/easycatalog/videos/videos.shtm
http://www.65bit.com/downloads/downloadpre.shtm
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i
For this tutorial, we will be importing data from 
a comma-separated values (CSV) file. Data 
can also be obtained directly from any ODBC-
compliant database with the use of an additional 
plug-in, the ‘ODBC Data Provider’, or from an 
XML structure using the ‘XML Data Provider’.

EasyCatalog adds a new sub-menu to the standard InDesign 
File→New menu - ‘New EasyCatalog Panel’. The top part of 
this menu shows the types of data that can be imported (the 
contents of this will depend on which of the optional plug-ins 
you have installed); the bottom part of the menu shows data 
you have previously imported.


Select the ‘New File Data Source...’ menu option 
- a file-picker dialog will open. Navigate to the 
‘stock.csv’ file included with this tutorial and hit 
the ‘OK’ button.

EasyCatalog will now examine the structure of the file and 
present the configuration dialog. Many of the values shown 
in this dialog will have been determined by EasyCatalog to be 
the most appropriate for the file. For example, EasyCatalog 
will attempt to determine the types of the field (such as 
Alphanumeric fields, numeric fields and currency fields) 
based on examining the contents of each of the columns.

Introduction
In this chapter, you’ll learn how to configure EasyCatalog so 
that you can import your data, and how to import your data 
into an EasyCatalog panel.

Configuring EasyCatalog
Once installed, EasyCatalog requires very little configuration 
to get started.  

EasyCatalog uses a ‘Workspace’ folder to store a snapshot of 
each data source when it is acquired.  The workspace folder 
stores, in addition to a local cache of data, configuration 
information for each data source you have imported into 
EasyCatalog. 

By default, the EasyCatalog workspace folder is stored in 
the following location:
Macintosh: 	 Documents:EasyCatalog Workspace 
Windows: 	 My Documents/EasyCatalog Workspace

The location of the Workspace folder can be found or 
modified in EasyCatalog’s general preferences, which can 
be found alongside InDesign’s preferences:

Macintosh: 	 InDesign→Preferences→EasyCatalog 
Windows: 	 Edit→Preferences→EasyCatalog

➀

➀ If you wish to change the location of your workspace 
folder, click the 'Choose' button.  The default location will 
generally suffice, so we won't change this option.

First Steps

Importing Your Data

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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The dialog is split into three main areas:

➀ The overall file configuration options, including the 
characters used in the file to separate fields and records:

➁ A preview of the data - this preview will be updated 
when any of the configuration options in the dialog are 
changed. This preview is an accurate reflection of how your 
EasyCatalog panel will appear.

➂ Field configuration options - settings that determine how 
each field should appear on the document can be configured 
here. Options such as field type (alphanumeric/numeric), 
currency formats and image paths can all be defined. To edit 
the options for a field, click in any field in the column you 
wish to configure and hit the ‘‘Options...” button.

Number Formats

We need to ensure that the currency fields are correctly 
configured (‘Inc. VAT Price’ and ‘Ex VAT Price’). 


Scroll the preview table to the right using the 
horizontal scroll-bar, and select the ‘Ex VAT’ 
column by clicking on any of the fields in the 
column. Click the ‘Options’ button to show the 
field configuration dialog.

 

The field configuration dialog behaves in a similar manner 
to the InDesign preferences dialog - a list of available 
properties is shown on the left, and the configuration options 
are shown on the right.

➀ ➁ ➂



➀ Ensuring that ‘Field Format’ is selected in the 
left-hand list, ➁ select ‘Currency’ from the field 
type popup. A number of pre-defined currency 
formats will be presented in the ‘Format’ popup 
- ➂ select ‘Dollar’.

Click ‘OK’ to confirm the changes to this field - 
repeat the above process for the ‘Inc. VAT Price’ 
field.

Images
Images can also be imported by EasyCatalog - each of the 
fields can be configured to define where the picture content 
files reside. 

!

Due to the number of records in the sample file 
(Stock.csv), we are unable to provide a folder that 
contains images for all of the records in the file.  
For the purposes of this tutorial we will not be 
configuring the location of images.

How are Images located?

EasyCatalog will use the content of a field as the filename 
for an image - for example, if your pictures are stored using 
a stock code as a filename, you would tag your image frame 
as ‘Stock Code’. 

The field used to identify the images may contain:

•	 A full path to the image - for example, your field may 
contain ‘Macintosh HD:Pictures:12345.jpg’. In this 
instance, the file will be imported from this location and 
the ‘Content Location’ specified in the Field Configuration 
dialog will be ignored, as will the ‘Extension’.

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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•	 The filename of the image with extension (e.g. ‘.jpg’) - for 
example, your field may contain ‘12345.jpg’. EasyCatalog 
will attempt to locate this image in the folder specified in 
the ‘Content Location’ specified in the FIeld Configuration 
dialog. The extension specified in the ‘Field Options’ will 
be ignored.

•	 The filename of the image - for example, your field may 
just contain ‘1234’ (as would be the case with stock 
codes, etc). EasyCatalog will look for this image in the 
‘Content Location’ path, and will append the ‘Extension’ 
specified in the ‘Field Options’ dialog.

Configuring Image Fields

Image fields are configured on the Field Options dialog:

➀ ➁

➂

➀ Select ‘Picture Content’ from the list on the left of the dialog, 
and ➁ hit the ‘Choose’ button in the ‘Content Location’ area 
of the dialog. Navigate to the folder containing your images.

➂ Enter the file extension of the graphic files you will be 
using (if appropriate) - for example, if you deal exclusively 
with JPEG files, enter ‘.jpg’ here.

That’s it!
Configuration of the data source is now complete - further 
configuration options are available, details of which can be 
found in the User Manual.

 Click ‘OK’ on the ‘File Data Source Configuration’ 
Dialog to create your first EasyCatalog panel.

 

Introduction
The EasyCatalog Panel is your view on the data - 
unlike contemporary plug-ins, your data is presented in 
spreadsheet-style panels. Using EasyCatalog Panels, data 
can be sorted, grouped, filtered - each panel also shows the 
current status of each record and field, such as whether it is 
placed on the current document.

Being able to see your data offers many other advantages - 
simply scroll around the table, select a field to insert in the 
document and hit the insert button, for instance. You do not 
need to know the SKU of a record in order to insert one of 
it’s fields.

Each panel is independent of the others - any queries, 
sorting or grouping configurations apply to a single panel. 
For example, you could have two panels open - one 
showing everything in the ‘Electrical’ department, one 
showing everything in the ‘Houseware’ department. You 
can even save a panel configuration and give it to another 
EasyCatalog user to work with!

EasyCatalog Data Panels

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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Sort columns by clicking in the 
table header, sub-sort by shift-

clicking in the header

The status column, which is always at the left of the panel, shows records that have been inserted, updated and deleted 
since data was last retrieved from the data source

Multiple data sources can be 
worked with simultaneously

Insert the selected 
field in the document

Query, or filter, the 
data displayed in the 

panel

Check the document to ensure 
the contents are the same as 

the data source

Individual columns can be 
shown, hidden and reordered

The status of each field and record is indicated 
by its colour in the panel:

The field is placed in the document and 
its content matches the source data.

The field is placed in the document but 
its content differs to the source panel.

This field was updated when the data 
was last retrieved.

The field has been updated from the document 
and needs updating in the data source.

This field was updated when the data 
was last retrieved, and the content in 
the document is different to the panel.

Data can be grouped in the panel - show or hide the contents of each group by clicking the 
disclosure triangle

All fields within this group are placed on the document and their content match the data 
source

One of the fields in this group is placed on the document, but it’s content does not match the 
data source

The number of sub-groups or items contained within  this group

This record has been inserted.

This record has been removed from the source data, and has effectively been deleted.  This record should be 
removed from the document.

This record was updated in the source data.  The fields that have changed will be shown in the red dotted 
outline.

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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Selecting Records and Fields

Select a field by clicking on it

Select a row by clicking it 
the status column

Using the Panel

Manipulating Data

Sorting Data
Data can be sorted and sub-sorted simply by clicking in the 
header area of the table.

➀ Sort a column by clicking in its header area

An icon shows the direction of sort - in this case, it is 
ascending. 

➂ To sub-sort, shift click in the header of the column you 
would like to sort by

A number now appears beneath the sort icon, showing 
the order in which fields will be sorted - in this instance, 

description will be sorted within Stock Code

➁ To reverse the sort-order, click in the column header again

Grouping Data
If your data contains hierarchical data - data that should be 
logically grouped by department, manufacturer, etc - the 
panel can also show the data in this hierarchical manner. 
More on grouping data is shown in Tutorial 6.

Reordering Columns
The order of the columns can be changed simply by dragging 
each column into position - the order of columns is important 
when inserting tables into a document as the columns in the 
document will appear in the same order as the panel.

Manually Reordering Records
Where simple sorting does not satisfy your needs, the order 
of the records can be manually adjusted simply by dragging 
them into position.

Querying/Filtering Data
If you only need to work with a sub-set of the entire database, 
apply a filter to the panel.

Create a query, or filter, by selecting ‘Show Subset’ from 
the EasyCatalog panel popout menu, or by hitting the ‘filter’ 
button ( ).

Data will only pass through the filter if all of the conditions are 
matched (‘Match All’), or any of the conditions (‘Match Any One’) 

Add or remove search criteria here

Select the field to 
filter on

Select the 
condition that 
must be met

Enter the value for the 
condition

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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The following tutorials have been designed to give you a gradual progression through some of the many features of EasyCatalog. 
More information on each feature can be found in the User Guide.

Tutorial 1 - Placing Fields, Errors and Updating the Document
This tutorial covers the basics - getting fields onto the document, checking the document for errors and updating the 
document. At the end of this tutorial, you will have experienced how easy it is to link data from your data source to the 
InDesign document, and how to ensure that your document is always up to date.

Tutorial 2 - Simple Tables
Using the power of EasyCatalog’s panels, you can easily construct simple tables in the document. At the end of this 
tutorial, you will have learnt how to use EasyCatalog panels as a preview of how your tables will look on the document.

Tutorial 3 - Product Styles
This tutorial introduces ‘Product Styles’  - what they are, and why you may want to use them. EasyCatalog lets you 
design how each record should look - no complex scripting language, or heavy learning curve.

Tutorial 4 - EasyCatalog Libraries
EasyCatalog Libraries are a convenient way of storing multiple Product Styles - this tutorial will show how to create an 
EasyCatalog Library, and how to populate the designs stored in them with real data. Using EasyCatalog Libraries, you 
can create complex page designs in seconds, or just experiment with different designs.

Tutorial 5 - Formatted Tables
Where you need to design tables for your publication, EasyCatalog can also help - simply show EasyCatalog how your 
table should look, and the table will be expanded or contracted to accommodate the amount of data being inserted.

Tutorial 6 - Grouping Data
Data that is structured hierarchically, such as by department and manufacturer, can be viewed in the panel in 
hierarchical form. The grouping configuration of the panel also affects the way in which groups are automatically 
paginated in the document.

Tutorial 7 - Text Flow Pagination
Requires the optional Pagination Module.
Automatically place many thousands of records - by creating a library of Product Styles, you can show EasyCatalog 
how each record (and group) should be paginated. For example, include designs for group headers and individual 
records in the library.

Overview

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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In this tutorial, you will learn how to:

•	 Place a field on the document 
How to place field in the document that is linked to 
the original data,

•	 Check the document for errors 
How to check the document for errors; how errors are 
shown in both the panel and on the document

• 	 Update the document 
How to update the contents of the document with the 
latest data from the data source

You should have already read the first chapter of this 
tutorial, ‘Getting Started’, and be familiar with how to use 
the EasyCatalog panel.

It is assumed that you have a panel open containing the 
‘stock.csv’ sample data file.

Using EasyCatalog, you can insert fields from your data 
directly at any point in an InDesign document.  EasyCatalog 
will link the data in the document to the text or picture 
content, allowing it to be updated with new data at a later 
date.  Any differences between the content in the document 
and the source data will also be highlighted.

Insering a text field

1
Start by creating an empty text box, ensuring you have 
a text insertion point

2 Select a single field in the EasyCatalog panel

3
Use the insert button to insert the 
selected field into the text box

The field is placed in the text box - field 
marker characters show the bounds of 
the field content. The markers are shown 
in green to indicate that the document 
content matches the original data.

Inserting a picture field

1 Start by creating an empty picture box

2 Select a single field in the EasyCatalog panel

3
Use the insert button to insert the 
selected field into the picture box

The field is placed in the picture box - the frame is tagged to show 
the key field value of the record that the image belongs to.  This 
frame tag is non-printing and will not be visible in Preview mode or 
when the document is output.

i Double click on a placed field in the panel to take you 
to the first instance of it in the document.

Tutorial 1 - Placing Fields, Errors and Updating the Document

Pre-requisites

Tutorial

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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Checking the Document for Errors

1
Modify the text inside of the field so that it no longer 
matches the original data

2
Use the ‘synchronize with document’ button at the 
bottom of the panel  to check the document for 
errors.

3
The field marker characters show in red on the 
document to indicate that there is an error - the field 
in the panel is also now shown in red

i If a field is shown as being in error in the panel, 
double clicking will take you to it in the document.

Updating the Document

1

Use the ‘Update Document’ menu on the EasyCatalog 
panel to update the document.

You can choose to update the entire document (‘All’), 
only the fields that are selected in the document 
(‘Selection’) or only the fields selected in the panel (‘With 
Panel Selection’)

2
The field will be updated on the document, and the 
panel will update to show the field is no longer in error

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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In this tutorial, you will learn how to:

• 	 Insert a simple table into the document

You should have already read the first chapter of this 
tutorial, ‘Getting Started’, and be familiar with how to use 
the EasyCatalog panel.

It is assumed that you have a panel open containing the 
‘stock.csv’ sample data file.

Tutorial 2 - Simple Tables

Pre-requisites

Tutorial

Column headers have been inserted, based on the field names. 
The columns widths are also proportioned the same as in the 
EasyCatalog panel.

The fields in the table behave like normal EasyCatalog fields, and 
are shown in green (placed) in the panel

Inserting a Simple Table

1
Start by creating an empty text box, ensuring you have a text 
insertion point

4 Hit the ‘Insert’ button to insert the table

2
Select the fields to appear in the table - to do this, 
first select the top-left field 3

While holding down the ‘Alt’ key, select the bottom-
right field - this will highlight all of the fields in the 
selected range

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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In this tutorial, you will learn:

• 	� What a Product Style is, and why you would want to use 
one

•	� How to construct a Product Style

•	� How to populate a Product Style with data

You should have already read the first chapter of this 
tutorial, ‘Getting Started’, and be familiar with how to use 
the EasyCatalog panel.

It is assumed that you have a panel open containing the 
‘stock.csv’ sample data file.

What is a Product Style?
A Product Style is a grouping of InDesign text and pictures 
boxes which form a design for how each individual record, 
or group of records, should appear in the document. 

Product Styles use place-holders (Field Specifiers) which 
show where field content should be inserted, and how the 
fields should appear (font size, style, etc).

For publications that feature a number of predefined styles, 
Product Styles can also be stored in EasyCatalog Libraries, 
allowing a collection of different styles to be stored and easily 
managed. When Product Styles are dragged to the document 
from an EasyCatalog Library, they are populated with the data 
for the record currently selected in the EasyCatalog panel.

Product Styles can also be used with the Pagination Module 
to automatically insert multiple records into the document.

What is a Field Specifier?

In order to show EasyCatalog where field content should go, 
EasyCatalog provides a means of inserting placeholders, or 
‘Field Specifiers’ into the design. 

Field Specifiers use blue field marker characters on the 
document, and can have styling applied in the same way 
as normal InDesign text. When populated with data, Field 
Specifiers will retain all of this styling information.

Graphic boxes can also be tagged with Field Specifiers, and 
during population the image referenced by the field will be 
imported.

Constructing a Product Style
Product Styles are simply an extension of existing InDesign 
functionality, so create your Product Style using all of the 
familiar InDesign tools. Where field content should appear, 
use the ‘Field Specifiers’ menu on the EasyCatalog panel to 
choose the field to insert.

!
In order for EasyCatalog to determine that all of 
the boxes belong to the same Product Style, they 
should be grouped on the document.

Tutorial 3 - Product Styles

Pre-requisites

Tutorial

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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Text Field Specifiers

Picture Field Specifiers

The Field Specifier has been inserted into the text
Styling can also be applied to the text - this will be retained when 
the Field Specifier is populated with data

1
To insert a Field Specifier, ensure you have a valid text 
insertion point

2
Use the ‘Field Specifier’ menu (from the EasyCatalog panel 
popout menu) to insert the Field Specifier

The frame has been tagged with the Field Specifier

1
To tag a picture box with a Field Specifier, ensure 
you have an empty frame selected

2
Use the ‘Field Specifier’ menu to tag the frame with 
the Field Specifier

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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How to populate a Product Style
Populating a Product Style is as simple as dragging a record from the EasyCatalog panel to any one of the boxes in the Product 
Style group on the document. The Field Specifiers will be replaced with field content for the dragged record, maintaining any 
formatting applied to the Field Specifier.

Drag
All boxes for this Product Style are grouped on 

the document

Field Specifiers have been replaced with field 
content for the dragged record

1

Drag the record you want to 
populate the Product Style with 
to the document by clicking and 
dragging from the left-most status 
column to the document.

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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In this tutorial, you will learn:

• 	 What an EasyCatalog Library is

•	 How to create an EasyCatalog Library

•	� How to use an EasyCatalog Library to create complex 
page designs in seconds

You should have already read the first chapter of this 
tutorial, ‘Getting Started’, and be familiar with how to use 
the EasyCatalog panel.

You should have also read Tutorial 3, which gives an overview 
of what a Product Style is and how to create one.

It is assumed that you have a panel open containing the 
‘stock.csv’ sample data file.

What is an EasyCatalog Library?
EasyCatalog extends the functionality of InDesign’s libraries 
by allowing designs with dynamic content - Product Styles 
(see Tutorial 3) - to be stored. When an item is dragged from 
an EasyCatalog Library to the document, it will be populated 
with the record(s) selected in the EasyCatalog data panel.

By storing all of your Product Styles in a library, complex 
page designs can be produced - populated with live data 
- in seconds.

Creating an EasyCatalog Library
There are two ways in which to create an EasyCatalog Library:

• Use the ‘File→New→EasyCatalog Library’ menu option - 
you will be asked for a file name and location to create your 
EasyCatalog Library

• Create, or open, a standard InDesign library and use the 
‘EasyCatalog Library’ option on the library’s pop-out menu.

Populating an EasyCatalog Library
Populate your EasyCatalog Library as you would a standard 
InDesign library - simply drag your Product Styles to the 
EasyCatalog Library.

Drag

Populating Product Styles from EasyCatalog Libraries 
with Data
Once your Product Styles are stored in an EasyCatalog Library, 
they can be populated with live data from an EasyCatalog 
panel by simply dragging them to the document. 

!
The ‘EasyCatalog Library’ option on the Library 
Panel's pop-out menu must be enabled on the 
library to replace Field Specifiers with field data.

 ➀ 	 Select a record to populate the Product Style with.

➁ 	 Drag the Product Style from the library to the page.

Tutorial 4 - EasyCatalog Libraries

Pre-requisites

Tutorial

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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Drag

The Field Specifiers have been replaced with field content for the 
selected record

Editing items in an EasyCatalog Library
To edit a Product Style stored in an EasyCatalog library, first 
disable the 'EasyCatalog Library' menu option.  Alternatively, 
you can drag the item to a new page whilst holding the Alt 
key to prevent it being propulated with data.

Once you have modified the Product Style, replace it in the 
library either by deleting the old item and then dragging 
the new item in or by using the 'Update Library Item' menu 
option.

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
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In this tutorial, you will learn:

•	� How to design tables that will be populated with a variable 
amount of data

•	 Populate a designed table

•	 How to store table designs in EasyCatalog Libraries

•	 Populate a table stored in an EasyCatalog Library

You should have already read the first chapter of this 
tutorial, ‘Getting Started’, and be familiar with how to use 
the EasyCatalog panel.

You should have also read Tutorials 3 and 4, which outline 
what a Product Style and an EasyCatalog Library are.

It is assumed that you have a panel open containing the 
‘stock.csv’ sample data file.


The example shown in this chapter can be found 
in the supporting files:  
http://www.65bit.com/downloads/easycatalog/
files/QuickStartGuide.zip

Introduction
When EasyCatalog encounters a table in a Product 
Style, it will attempt to add or remove rows in the table to 
accommodate the amount of data being paginated.  By 
simply defining a prototype row containing Field Specifiers, 
EasyCatalog can quickly populate complex tables that can 
include headers, sub-headers and even merge cells together 
where content matches.

Designing your table

Field Specifiers can also be included in table designs, 
allowing you to design how your tables should look. This 
table design can also be stored in an EasyCatalog Library for 
later population. 

 Insert a new table into an empty document with 
the following parameters:


Using the Field Specifier menu, insert a Field 
Specifier for the 'Manufacturer' field into the table 
header; 'Manufacturer Part Code' into column 1; 
'Description' into column 2 and 'Inc VAT Price' in 
column 3.

Normal InDesign formatting options can be applied to 
the table, cells and text.  These will be preserved when 
populating the table with data.

Populating the table
Drag Records to the table from the panel
The table can be populated with data simply by dragging 
and dropping data from the EasyCatalog data panel to the 
table in the document.

 Click in the left-most column of the first record to 
populate the table with.

 Hold 'Alt' and click in the left-most column on the 
last record to use.

Tutorial 5 - Formatted Tables

Pre-requisites

Tutorial
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 Drag the records from the panel to the table

DRAG

The table will now be populated with the selected records. 

The table header has been populated with data from the first 
record; the main body of the table has been expanded to 
accommodate the amount of data.

Populate the table from an EasyCatalog Library
If your table is stored in a Product Style within an EasyCatalog 
Library, it will be populated with all records selected in the 
panel when the library item is dragged to the document.

 Create a new EasyCatalog Library using the 
File→New→EasyCatalog Library menu option.

DRAG


In the data panel, select the records you would 
like to populate the table with and drag the library 
item to the document.

DRAG

The table will be populated with the data selected in the 
panel.
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In this tutorial, you will learn:

•	 How to group data in the EasyCatalog panel

• 	� How to work with hierarchical data in the EasyCatalog 
Panel

•	 How to specify the sort-order of groups

You should have already read the first chapter of this 
tutorial, ‘Getting Started’, and be familiar with how to use 
the EasyCatalog panel.

It is assumed that you have a panel open containing the 
‘stock.csv’ sample data file.

Grouping Data
When working with large volumes of data, or data that is 
hierarchically structured (i.e. contains groups and subgroups, 
such as department and manufacturer), EasyCatalog can 
group the data. This not only makes working with the data 
easier, as it is presented in a hierarchical manner, but it also 
affects operations such as automatic pagination (headers 
can be inserted on change of group, for instance).

EasyCatalog provides a grouping configuration dialog to 
allow you to specify the hierarchical structure of the data 
and how the data should be sorted within each group. The 
grouping configuration only applies to individual panels, so 
different grouping configurations can be applied to different 
panels.

 Display the ‘Grouping Configuration’ dialog by 
selecting ‘Group...’ from the EasyCatalog panel.

The left-hand side of the dialog shows fields the are still available 
(not used in the current grouping configuration)

The right-hand side of the dialog shows the current grouping 
configuration

In this example, we’ll group the data by three levels: ‘Parent 
Category’, ‘Child Category’ and ‘Manufacturer’.  This will 
produce a panel with a three level hierarchy.


➀ Select the first field to group by, ‘Parent 
Category’ and hit the add button. Alternatively, 
double-click on Parent Category

➁ Now do the same for ‘Child Category’ and 
‘Manufacturer’

The configuration will appear on the right-hand side of the dialog

Working with groups in the EasyCatalog Panel
Once grouped, your data will appear in a hierarchical form in 
the EasyCatalog panel.

The panel will show the new hierarchy of the data. Click the 
disclosure triangle to expand or contract each group

The number of sub-groups is shown on each group row  

Tutorial 6 - Grouping Data

Pre-requisites

Tutorial
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Changing the order of the groups
The sort order of the groups in the panel can also be specified 
on the ‘Grouping Configuration’ dialog:

Select one of the rows on the right-
hand side, then use the ‘Ascending’ and 
‘Descending’ radio buttons to adjust the 

sort-order of the group

Ungrouping the panel
To revert back to a record list, select ‘Ungroup’ from the 
EasyCatalog panel pop-out menu.
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In this tutorial, you will learn:

•	� How to use the Pagination Module to automatically insert 
hundreds of records into a document.

•	 What the ‘Flow-based’ pagination is and when to use it.

•	� What the ‘Pagination Rules’ panel is and how to use it to 
configure the Pagination module.

You should have already read the first chapter of this 
tutorial, ‘Getting Started’, and be familiar with how to use 
the EasyCatalog panel.

It is assumed that you have a panel open containing the 
‘stock.csv’ sample data file.

!
This tutorial requires the optional pagination 
module which is available at additional cost.


This tutorial uses a number of supporting files 
which can be downloaded from our web site:

http://www.65bit.com/downloads/easycatalog/
files/QuickStartGuide.zip

Installing the Pagination Module
The Pagination Module is an optional module which is 
available in the main EasyCatalog installer.  During the 
installation process, ensure that the “Pagination Module” 
option is checked when prompted. 

What is the Pagination Module?
Through the use of the Pagination Module, EasyCatalog can 
insert hundreds or thousands of records into a document 
automatically.  By creating a library of Product Styles, the 
Pagination Module can insert your data into the document 
and even choose different Product Styles for different 
records.

In many cases, the Pagination Module can be used to 
automate or semi-automate the production of many different 
types of publication.

The data selected in the panel - and the structure (e.g. 
grouping) - of the data is used during the pagination process.  
This allows library items to be configured that will be inserted 
at, for example, the  start of each group.

What is flow-based pagination?
Flow-based pagination is the most widely-used form of 
pagination, and is ideal for situations such as:

- Production of price lists, catalogs and directories where 
information flows through a document.

- Where the document should reflow if a record is added, 
removed or moved.

Each Product Style is inserted into an InDesign text flow, 
either as standard InDesign text or as anchored items within 
the flow.  

Simple Flow-based Pagination Tutorial
In this example, we’ll look at the simplest form of automatic 
pagination, whereby we’ll create a flow of text - headers will 
be introduced later.

 Open the library ‘Tutorial 7a.indl’ from the Quick 
Start Guide supporting files.

The ‘Tutorial 7a.indl’ library consists of a single library item, 
which is a prototype that shows EasyCatalog how to insert 
each record into the document. In order to tell EasyCatalog 
when this library item should be used, the Pagination Rules 
panel is used.

Tutorial 7 - Text Flow Pagination

Pre-requisites

Tutorial
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 If the ‘Pagination Rules’ panel is not already 
visible, show it from the ‘Window’ menu.

The Pagination Rules panel shows the attributes assigned to 
the currently-selected box in the document.

 Drag the library item from ‘Tutorial 7a.indl’ to a 
new, empty, document.

This library item simply consists of two Field Specifiers in a 
single text box, separated by a tab. 

The Pagination Rules panel will now update to show the 
attributes assigned to this library item.  These attributes are 
used to instruct EasyCatalog when to use this library item, 
how to insert it into the document and whether to apply 
an additional processing (such as fitting the frame to its 
content).

➀

➁
The two most important attributes are the ‘Paginate’ and 
‘Insert’ attributes:

➀ 'Paginate’

This option is set to ‘Once Per Record’. 
This instructs EasyCatalog to use this 
library item each time it wants to insert a 
record from the data panel.

➁ ‘Insert’

There are two possible options for this 
attribute: ‘Frame Contents’ will insert the 
contents of the frame only; ‘As Inline’ will 
anchor the text box into the pagination text 
flow.

Paginating the data
Flow-based pagination requires a normal InDesign text frame 
to flow the data into.  If the text frame you're paginating into 
is from a master page, new pages will be inserted into the 
document automatically when required.

 Create a new document with the following 
options:

➀

➁
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➀ 'Master 
Text Frame’

A text frame will be created on the 
A-Master to paginate into.

➁ Columns In this example, we are paginating into a 
two column document.

Flow-based pagination requires a text insertion point in 
the document.  At the moment, the text frame we want to 
paginate into is on the master page: to be able to paginate 
into it, we first need to override the master text frame on 
page 1 of our document.


To override the master text frame on page 1 
- and allow us to flow text into it - hold down 
Shift + Apple (Macintosh users) or Shift + CTRL 
(Windows users) and double-click in this area.

You should now have a flashing text insertion point, so the 
next step is to select the data to paginate:

 Click in the left-most column of the first record 
to paginate.

!
If your panel is grouped, ungroup it using the 
'Ungroup' menu option.

 Hold 'Alt' and click in the left-most column on the 
last record to paginate.

 Now select 'Paginate' from the data panel's pop-
out menu.

➀

➁


➀ On the 'Paginate' dialog, hit the 'Choose' 
button and select the pagination library.

➁ Click 'OK' to commence pagination.
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After a few moments, EasyCatalog will commence pagination 
of the selected data.  It will examine each of the records 
selected in the panel, populate the library item and paste 
the content into the pagination text flow.  Once pagination 
is complete, you will have a standard InDesign text flow that 
can be manipulated as normal.

UK TELEPHONE STRAIGHT EXT ...........................£3.52

RETRACTABLE PHONE CORD ............................£12.92

RJ11 to BT Adaptor Cable ........................................£1.98

Uk Telephone Ext Cable - Coiled ( 5m ) ...................£4.11

BT 3 Way Splitter ................................................
......£5.87

Modular Patch Cord - RJ11/RJ11 .............................£1.76

Modular Patch Cord - RJ11/RJ12 ( 30.3m) ..............£5.87

Modular Patch Cord - RJ11/RJ13 .............................£2.34

Modular Patch Cord - RJ11/RJ14 ( 7.5m ) ...............£2.93

Modular Patch Cord - RJ11/RJ15 ( 14.2m ) .............£4.69

UK Telephone Extension - Straight (10m) ................£8.22

UK Telephone Extension - Straight (15m) ................£9.39

Uk Telephone Cable Extension Reel - 

TwinSocket 10m .................................................
....£11.75

UK Telephone Extension Reel -Twin Socket- 

15m.................................................
..........................£8.22

UK Telephone Extension Reel - Single 

Socket (3m) ................................................
..............£2.34

UK Telephone Extension Reel - Single 

Socket (5m) ................................................
..............£3.52

UK Telephone Extension Reel Single 

Socket/Dual(10m .................................................
.....£5.87

USA to BT Socket Adaptor .......................................£3.52

RJ11 Male - BT Plug Male Cable - (2m) ...................£2.34

RJ11 Male - BT Plug Male Adaptor ..........................£2.34

BT Plug - USA Socket Adaptor .................................£3.52

RJ11 - BT Socket ................................................
......£5.87

Polaris Cable For Telephone Headset Port ............£11.75

Ultra320 Int 24” LVD SCSI Cbl ...............................£29.37

10” Round FDD Clear ...............................................£
7.00

24” ATA133 Round Cable .........................................£6.49

FAST & WIDE SCSI;68 POS ..................................£24.67

INTERNAL SCSI 3 CBL;3 DRV ..............................£50.52

INTRNL SCSI3 CBL;7DRV 68P .............................£70.50

SCSI I/SCSI III INT ADPTR ....................................£10.57

SCSI III/SCSI I INT ADPTR ....................................£10.57

ULT ATA133 RND CBL;40SOK ................................£8.22

ULT ATA133 RND CBL;40SOK ................................£9.39

ULT ATA133 RND CBL;40SOK ................................£9.39

ULT ATA133 RND CBL;40SOK ................................£8.22

ULT ATA133 RND CBL;40SOK ................................£9.39

ULT ATA133 RND CBL;40SOK ................................£8.22

ULT ATA133 RND CBL;40SOK ................................£9.39

ULT ATA133 RND CBL;40SOK ..............................£10.57

ULT ATA133 RND CBL;40SOK ................................£7.04

ULT ATA133 RND CBL;40SOK ................................£8.22

ULT ATA133 RND CBL;40SOK ................................£8.22

ULT ATA133 RND CBL;40SOK ................................£7.04

ULT ATA133 RND CBL;40SOK ................................£8.22

ULT ATA133 RND CBL;40SOK ................................£7.04

SERIAL ATA 2.0 CABLE ...........................................£5.87

SERIAL ATA 2.0 CABLE ...........................................£5.87

SERIAL ATA 2.0 CABLE ...........................................£7.04

SERIAL ATA 2.0 CABLE ...........................................£5.87

SERIAL ATA 2.0 CABLE ...........................................£7.04

SERIAL ATA 2.0 CABLE ...........................................£8.22

SERIAL ATA 2.0 CABLE ...........................................£4.69

SERIAL ATA 2.0 CABLE ...........................................£4.69

SERIAL ATA 2.0 CABLE ...........................................£5.87

SERIAL ATA 2.0 CABLE ...........................................£4.69

POWER Y SPLITTER CBL;5.25 ..............................£2.34

DISK DRIVE POWER EXT CBL ...............................£2.34

Y POWER CABLE;2x 3.5” DRV ...............................£3.52

Y POWER CBL;1-5.25””1-3.5”” ................................£5.87

PAR/SERIAL HD POWER CABLE ...........................£4.69

PAR/SERIAL HD POWER CABLE ...........................£5.87

SCSI HEADER 50 PIN TO .....................................£11.75

50SOK 1DRV RIBBON CABLE ................................£3.52

34SOK 2DRV ROUND CABLE ................................£5.87

34SOK 2DRV ROUND CABLE ................................£7.04

34SOK 2DRV ROUND CABLE ................................£4.69

34SOK 2DRV ROUND CABLE ................................£4.69

34SOK 2DRV ROUND CABLE ................................£5.87

34SOK 2DRV ROUND CABLE ................................£7.04

34SOK 2DRV ROUND CABLE ................................£4.69

34SOK 2DRV ROUND CABLE ................................£4.69

34SOK 1DRV RND FLOPPY CBL ............................£4.69

34SOK 1DRV RND FLOPPY CBL ............................£4.69

34SOK 1DRV RND FLOPPY CBL ............................£5.87

34SOK 1DRV RND FLOPPY CBL ............................£3.52

34SOK 1DRV RND FLOPPY CBL ............................£3.52

34SOK 1DRV RND FLOPPY CBL ............................£3.52

Ultra ATA Round Ribbon Cable ..............................£14.09

18” ATA133 Round Cable .........................................£5.99

18” Floppy Round Cable...........................................£5.99

24” Round ATA133 Clear ..........................................£7.00

Floppy Cable I34F-I34F-I34F ...................................£3.52

IDE HDD Cable I40F-I40F-I40F UDMA33 ................£2.34

IDE HDD I40F-I40F-I40F 70cm ................................£5.87

Optra 1200N HDD Adaptor Cable ..........................£23.50

UDMA66 IDECable I80F-I80F-I80F..........................£5.87

Cascade Cable .................................................
......£29.37

SuperStack Matrix Cable ........................................£76.37

SuperStack II Cascade cable .................................£29.37

LVD terminated SCSI dual drive ribbon 

68pin .................................................
......................£62.39

LVD terminated SCSI 7drive ribbon 68pin 

males .................................................
.....................£52.87

50 pin 2drive SCSI cable 10”/19”..............................£7.04

68pin SCSI Ribbon 2drive cable.............................£18.79

Ultra DMA ATA33,66 & 100 rated dual IDE 

drive cbl ................................................
..................£10.57

50 pin 3 drive SCSI cable 7”/8”/8” ............................£4.69

50 Pin Internal 5 Position Fast SCSI Cable 

1.3m.................................................
.......................£29.37

Standard IDE ribbon cable for 2 IDE ATA33 

Simple flow-based Pagination Example

Headers
The next step in our pagination will be to include headers 
into the flow of text.  The sample data has a simple three 
level hierarchy - 'Parent Category', 'Child Category' and 
'Manufacturer' - and we want to include headers at the start 
of each of these levels.

The first stage in the process is configuring the EasyCatalog 
data panel to show this hierarchy.  As shown in Tutorial 6, the 
data panel can be grouped.

Follow the instructions in Tutorial 6 to group your panel by 
'Parent Category', 'Child Category' and 'Manufacturer'.  

We now need to show EasyCatalog how each header should 
appear in the document.  This is achieved by including 
prototypes for each of the different levels in the hierarchy in 
the pagination library.

 Drag the 'Parent Category' library item from 
‘Tutorial 7b.indl’ to a new, empty, document.

This library item simply consists of a single Field Specifier in 
a single text box.

As before, the Pagination Rules panel will now update to 
show the attributes assigned to this library item. 

 

➀ ➁

➂
This library item has three main attributes specified:

➀ 'Paginate’

This option is set to ‘Once Per Group’. This 
instructs EasyCatalog to use this library 
item each time it encounters a new group 
in the panel.

➁ ‘Group 
Name’

The name of the group level that this library 
item paginates at.

➂ ‘Insert’
This option is set to 'As Inline', which will 
anchor the box in to the pagination text 
flow.

Similarly, the other two header library items have similar 
Pagination Rules set - only the 'Group Name' attribute 
differs:
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So, to summarize, Tutorial 7b.indl contains four library items: 
one for each of the levels on the grouping hierarchy in the 
panel.  We have three library items whose Pagination Rules 
define that they should be used for three different levels 
in the grouping, and one library item that will be used to 
paginate each record.

i
It is not necessary to have a library item for each 
of the levels in the hierarchy. For example, if a 
header is not required at the 'Child Category' 
level, then the item can be ommitted from the 
library.

 Create a new document with the following 
options:

➀

➁


Follow the instructions in 'Paginating the Data' 
(above) to override the master text frame 
on page 1.  Ensure you have a flashing text 
insertion point in the document.

As before, we now need to select the data we wish to 
paginate.  This time, however, we are selecting the groups 
we want to paginate:

 Click in the left-most column of the first group to 
paginate.

 Hold 'Alt' and click in the left-most column on the 
last record to paginate.

 Now select 'Paginate' from the data panel's pop-
out menu.

➀

➁


➀ On the 'Paginate' dialog, hit the 'Choose' 
button and select the pagination library.

➁ Click 'OK' to commence pagination.
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Audio Separates

Analogue Radio Tuners

Sony

ST-SE370S Silver E-Line Tuner .............................£90.00

ST-SA3ESB Black Tuner ....................................
..£278.47

ST-SA3ESN Gold Tuner ....................................
...£278.47

Audio Hard Disk Recorders

Sony

HAR-LH500 Hard Drive Recorder ........................£325.99

HAR-D1000 Audio Hard Drive Recorder/CD 

Deck .....................................
................................£468.82

AV Ampli�ers & Receivers

Creative

Decoder DDTS-100 .....................................
...........£99.87

Sony

STR-LV500 Receiver ....................................
........£219.72

STR-DE695B Receiver Black ...............................£219.72

STR-DE695S Receiver Silver...............................£219.72

STR-DB790B QS Receiver Black.........................£245.57

STR-DB790S QS Receiver Silver ........................£245.57

STR-DB2000S QS Receiver Silver ......................£381.87

STR-DA3000ESB ES Receiver Black ..................£652.12

STR-DA3000ESN ES Receiver Gold ...................£652.12

STR-DA5000ESB ES Receiver ............................£815.44

STR-DA5000ESN ES Receiver Gold ...................£815.44

STR-LSA1 LISSA Receiver ..................................£
334.87

Cassette Decks

Sony

TC-KA6ESN ES Cassette Deck ...........................£570.00

TC-WE475B Black E-Line Twin Cassette 

Deck .....................................
................................£115.14

TC-WE475S Silver E-Line Twin Cassette 

Deck .....................................
................................£115.14

TC-WE675 E-Line Twin Cassette Deck ................£156.27

CD Players/Recorders

Sharp IT Products

DX-SX1 1 Bit Cd player ....................................
.£2,698.97

Sony

SCD-555ESB CD Player in Black......................£1,116.25

SCD-1 Super Audio CD Player ..........................£3,218.32

CDP-XE270B E-Line CD Deck ...............................£76.37

CDP-XE270S E-Line CD Deck ...............................£81.07

CDP-XE370 E-Line CD Deck .................................£92.82

CDP-CX355 300 CD Changer ..............................£190.00

SCD-XB790B Audio CD Player Black ..................£245.57

SCD-XB790S Audio CD Player Silver ..................£245.57

SCD-XA3000ESN Audio CD Player Gold.............£652.12

SCD-XA9000ESN Audio CD Player Gold..........£1,957.54

DAB Radio Tuners

PURE DIGITAL

DRX-701ES - Silver ....................................
..........£205.62

DRX-701ES - Black .....................................
.........£199.99

Pure DRX-601EX .....................................
............£487.62

Sony

ST-D777ES ES Range DAB Tuner.......................£646.25

DVD Audio Players/Recorders

Philips IT products

DVDR 75 .....................................
.........................£421.82

DVDR 70 .....................................
.........................£292.57

HiFi Ampli�ers & Receivers

Sharp IT Products

!"#!$%&%&'()&*+,-(./0.............
..........................£3,299.39

Sony

1*#2*34445!6&5!&*+,-(./0 ..
..........................£2,122.04

1*#2*34445!7&58&*+,-(./0&9
:-; ....................£2,122.04

1*#<*===5!&5!&>?0/&*+,-(./
0 .........................£1,386.50

1*#<63@4A&B!&>?0/&*+,-(./0 
.............................£289.00

TA-E1 Linear Phase Circuit Stereo Pre-

C+,-(./0 ...................................
..........................£3,453.32

TA-N1 Linear Phase Circuit Stereo Power 

*+,-(./0...................................
..........................£5,308.64

1*#<63@4!&B!&>?0/&*+,-(./0&
!(-D/0 ...................£289.00

1*#<5E=46&5#F(G/>?0/&*+,-(.
/0 .........................£115.00

MiniDisc Players & Recorders

Sony

MDS-JE480B E-Line MiniDisc Black ....................£108.00

MDS-JE780B E-Line MiniDisc Black ....................£212.67

MDS-JE780S E-Line MiniDisc ..............................£212.67

NetMD QS MD Recording Deck Black .................£229.12

NetMD E-Line MD Recording Deck Silver ............£211.49

NetMD QS MD Recording Deck Silver .................£229.12

MDS-JE480S E-Line MiniDisc ..............................£108.00

Turntables

Sony

PS-LX250H Automatic Turntable ............................£82.25

PSJ-20B Mini Turntable Black ................................£92.82

PSJ-20S Mini Turntable Silver ................................£92.82

Audio/Video Systems

HiFi Systems

DabsValue

Micro-HiFi - Radio/CD .....................................
.......£34.99

Micro Hi-Fi System - CD/Radio ..............................£29.99

Panasonic

SC-AK300 Mini System with CD, Tape and 

tuner ....................................
.................................£210.32

SCH-T75......................................
.........................£346.62

SC-PM10 Micro System .....................................
..£116.32

SC-DP1 DVD-Video Hi-Fi System ........................£217.37

Sharp IT Products

XL-HP550H Micro System....................................£
170.37

CDE250E Mini System .....................................
....£116.32

Sample Pagination output including headers

Automatically inserting page breaks
EasyCatalog can also automatically insert page breaks 
when paginating a library item. The Pagination Rule 'Force 
Break' can be used to specify that the library item should be 
inserted on a new page, in a new frame or in a new column.

 Drag the library item from ‘Parent Category’ from 
'Tutorial 7b.indl'  to a new, empty, document.

 Double click on the 'Force Break' attribute in the 
panel to edit it.


Change the attribute to 'Page Break'.

Update the library item in the Pagination library.

When inserting this library item into the document, 
EasyCatalog will ensure that it starts on a new page.

!
After changing a Pagination Rule, ensure that 
you update the library item by using InDesign's 
'Update Library Item' option.

http://www.65bit.com
mailto:support@65bit.com
http://twitter.com/65bitsoftware
http://help.adobe.com/en_US/InDesign/6.0/WSB563B522-0E6F-4a26-A5C5-97E84AC9377Ca.html#WS5F5C7CBE-2E7A-4802-92CA-9218412341F8a
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About 65bit Software

65bit Software Limited was founded in 2003 and specializes in the development of high quality Plug-ins for Adobe InDesign 
and InCopy. 

We believe that the growing processing power of today’s desktop computers is allowing the development of a new breed of 
tools, offering levels of integration, power and ease of use previously only seen in high end publishing systems. 

At 65bit we are committed to providing best of breed solutions for the database publishing, catalog, newspaper and magazine 
markets. 

In addition to developing InDesign Plug-ins, we offer custom development services and can help you to design and implement 
an InDesign or InCopy-based solution. You can learn more about our services or submit a request for more information by 
sending mail to sales@65bit.com 

DAM/System Vendors - Any of our products can be included and branded as part of your solution. Please contact sales@65bit.
com for more information. 

Contact Details

Postal: Meriden House 
6 Great Cornbow 
Halesowen 
West Midlands 
B63 3AB

Web: http://www.65bit.com

Sales: sales@65bit.com

Support: support@65bit.com 
http://www.65bit.com/support

Twitter: http://www.twitter.com/65bitsoftware

Feedback: We welcome all feedback and bug reports on 65bit products. Please email any comments to:	
support@65bit.com 

65BIT
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